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Foreword 
 
MyCar-Monitor is a car care software what I has originally written for myself in order to 
monitor the behavior of my car but later I decided to make it available for all people. 
Progamming was started in 2005 and now in 2009 it has reached a near final phase. Now it 
contains all the significant functions and modules what I imagined in 2005. From 2009 I 
plan to concentrate on the bug fixes, fine tunings and smaller improvements.  
 
The reason of the free of charge status is to see the popularity of it and get as many useful 
feedbacks as possible. And of course the fundamental and primary target is to reach 
thousands of downloads and registrations all over the world.  
 
I'm welcome any comments or ideas by email in English or Hungarian language. 
Email me, if you like this software. It's really useful for me to receive your e-mail messages 
to keep working on modifying and improving this software. 
Your help is appreciated in the following ways: new or modified language files, pictures, 
logos, ideas, tests, advertisement (e.g.: link on your site), etc…. 
If you want to contribute to the development of MyCar-Monitor, please send email to 
simadcom@freemail.hu or simadcom@gmail.com  
Your contribution is rewarded by providing VIP right for MyCar-Monitor. (VIP mode means 
full availability of the functions and as prompt reaction on your emails as possible). 
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Copyright 
 
The FREE MyCar-Monitor is distributed as Freeware, but free registration is expected. I will 
do my best to provide this free status as long as possible. The purpose of this registration 
demand is to know the popularity of my software and to get as many feedbacks from the 
users as possible in order to give me more energy for the further development.  
 
My expectation concerning the copyright as follows: 

• All copyrights to FREE MyCar-Monitor are exclusively owned by SimADCom. 

• The FREE MyCar-Monitor may be freely distributed only if it is subject to the 
following conditions: 

- the distribution package is not modified. 
- no person or company may charge a fee for the distribution of FREE MyCar-

Monitor without a written permission from the copyright holder, except to 
recover the media costs. 

- the FREE MyCar-Monitor may be bundled or distributed together with any 
other products or packages, but the same conditions apply. 

 
Warranty conditions: 

• FREE MyCar-Monitor IS DISTRIBUTED "AS IS". NO WARRANTY OF ANY KIND IS 
EXPRESSED OR IMPLIED. YOU USE IT AT YOUR OWN RISK. SIMADCOM WILL NOT 
BE LIABLE FOR DATA LOSS, DAMAGES, LOSS OF PROFITS OR ANY OTHER KIND OF 
LOSS DUE TO THE USE OR MISUSE OF THIS SOFTWARE. 

 
Licenses: 

• All rights not expressly granted here are reserved to SimADCom. 
• Installing and using FREE MyCar-Monitor indicates your acceptance of the terms and 

conditions of the license. 

• If you do not agree to the terms of this license you must remove FREE MyCar-
Monitor files from your storage devices and cease to use the product. 

 
If you want to register: 

• Free registration means that a simple and free registration process is necessary to 
obtain all the function of the software. In order to get the registration codes, you 
have to send an email to simadcom@freemail.hu address with „registration request” 
in the subject. In the auto reply, you will get the codes with which you will be able 
to activate all the function of MyCar-monitor (except VIP menu).  

 
Support 

• I will do my best to provide support but I can not guarantee that every request will 
be answered.   

• Support language is English or Hungarian. In special cases Spanish support is also 
available.  

• Support is provided only in written (voice calls via MSN and Skype are not 
accepted).  

o Email: simadcom@freemail.hu, simadcom@gmail.com  
o Skype: simadcom 
o MSN: simadcom@freemail.hu 

  
© 2005-2009 SimADCom 
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System Requirements 
 
Minimum requirement 
Operating Systems 

Windows 2000  
Windows XP  
Windows Vista 

Minimum Hardware 
CPU 400 MHz  
128 MB RAM  
200 MB hard drive space 

Display 
Display resolution: 800X600 (recommended: 1024x768 or higher) 

Network 
Internet connection (recommended for online upgrade and newsletter functions) 

 

User has to have right to write into the folders where MyCar-Monitor is located.  If this 
condition is not available, the software will not run and be automatically closed after 
launching.   
 

If above requirements are not found on the PC, installation will not be possible and 
interrupted.  
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Installation and Upgrade 
 
This software requires a standard installation.  
 

 IF SERIOUS PROBLEM IS DETECTED BY THE SOFTWARE DURING THE 
LAUNCHING PROCESS, THE SOFTWARE WILL BE CLOSED 

AUTOMATICALLY! 
 
 
Installation 
 

- download installation package 
- execute 
- a notice will be displayed saying that the default folder is recommended for 

the installation 
 

               
 

- next screen diplays the installation folder which can be changed if needed 
- admin users are allowed to install MyCar-Monitor only for themselves 
 

 
 

- next screen displays the End User License Agreement which has to be 
accepted for the finishing of the installation. 
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- when the installation has been finished, on the last screen the user is able to 
launch the Mycar.exe and read the readme.txt file right away after the 
installation.  
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Next section decribes the first launch settings, supported by a Quick Setup Wizard. 

 

• Quick Setup Wizard will start automatically helping the user to adjust the basic 
settings, 

 
 

 
 
 

• Select language what you would like to use (in case of no selection, default English 
language will be used), 

 
 

 

 

 
 

• You can see the available features of the software and decide that you need to 
register it or not. Clicking on the “Code request” button an email will be launched 
what you have to send without modification. It will use your default email client. 
Automatic reply will contain the registration code and hopefully arrive until you have 
gone through the Quick Setup Wizard.  

 



10 / 131 

 
 

• You can create a new vehicle database in two steps 
o Specify the name of the database (usually registration number) 
o Fill out the vehicle datasheet with vehicle specified information 

 

 
 

• You can specify the measure which is used in your country (it can be modified later) 
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• Test and set the online upgrade function, if you want to use it in the future (details 

are described later) 

• Testing of the online upgrade function as follows: 
• Click on the test button and wait until a message box appears. If the test was 

successful, you will be able to set and use this function for new version checking. In 
case of unsuccessful result you can not use this function on your computer. If you 
could not perform a successful testing, this function will be completely disabled. You 
will be able to try to set it later on the setting form. 

• If you use a firewall, you will have to give permission to MyCar-Monitor to reach the 
internet and connect to the download server.  

 

 
 

 
 

• You can create an icon onto the desktop if you want (not available) 
• You can set all the software function on the general setting panel, 
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• Quick Setup Wizard process has been finished. 
 

 
 

• Click on OK, and software will go further. 
 

 
 

• In order to use the software, you must accept the End User License Agreement. 
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• If you have already received the registration code, you can register the software 
now by entering the code into the black field and clicking on the Validation button.  

 

 
 

• When all “First time” operation has been finished, you will get the normal Logon 
screen where you can choose what you would like to do.  

o Create new database: add new vehicle  
o Open existing database: additional form will displayed (if two or more 

databases are available) where you can select the required one.  
o Open last used database: self-explanatory. 
o Thanks, I will … : this form will be closed, you can continue as you want.  
o Switch to professional version: optional for XP or higher operating systems. 
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Online Upgrade 
If online upgrade function is available and adjusted on your computer 

• MyCar-Monitor will inform you about the availability of the new version, 
 

 

 

• Clickin on the Download & Install Now! Button the upgrade will be performed right 
away after downloading of the new version.  

• If check upgrade function is not set, the user is able to check for updates by using 
the given function (check for updates) it the Help menu. In this case the following 
screen will display: 

 

 
 

• If now update is available the user will be notified by the following message 
 

 
 

• In case of availability of new update, the screen, described above will be displayed.  
In special cases I will release so called patches/hotfixes which will be appeared on a 
different screen, but the procedure is the same as described here. 
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Uninstallation 
 
You can uninstall MyCar-Monitor by three different methods 

- use link which can be found in the Start menu, 
- launc uninstall exe file which can be found in the setup folder 
- use windows Add/Remove Programs function. 

 
 

Portability 
 
Theoretically this application can be used on USB drive, if the following criteria’s are 
fulfilled:  

• installed version is copied onto an USB drive (no install is possible onto a portable 
USB drive) 

• all the linked files such as receipts, police documents or wallpaper are located in the 
receipt folder (there is no link out of MyCar-Monitor folders), 

• date format is the same on all the computer. Date format is not automatically 
changed in the databases! Different date formats may cause error! Note: date 
handling has been improved, so theoretically it should not cause problem.  

• do not try to automatically upgrade the application located on an USB drive!  
 
Following the above mentioned rules you will be able to use this software in portable mode 
on any computer.   
 

Registration 
 
In order to know the popularity of our software a simple free registration is expected. 
You can obtain the codes as follows: 

• Send an email to simadcom@freemail.hu with „registration request” in the 
subject. 

• Automatic reply will contain the codes. 
 
Buttons: 
Exit – interruption of the software running, 
Code request – email will be generated using your default email client, 
Validation – code checking and limitation removal, if correct code has been entered, 
Later – in case of not-registrated copy of MyCar-Monitor, you have to wait a certain time 
for the button to be activated. Maximum waiting time is 60 seconds.  
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Tip of the Day 
 
Our software has been equipped with some useful advices, which can be seen on the „Tip 
of the Day” panel. 
You can switch this function off by removing the ticking from the „Show tips at start-up” 
box and click on the Close button. 
Messages can be found in the *.tip files in the language folder. 
 

 
 

How to start? 
 

• Mycar.exe has to be launched. 
• Wait until the status indicator disappears and the version number will be 
visible! 

 

 
 

• If online function is enabled, this launching process may takes longer.  
• If wallpaper is set, the following main screen will appear. Wallpaper can be set on 

the Settings panel.  
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• If wallpaper is not set, the following main screen will appear. 
 

 
 
Using the below shown menu the button style can be changed. (right click on the menu) 
 

 
 
Statusbar contains the base information: version, language, operating system, status of 
online upgrade and newsletter, application location.  
 

• Now, MyCar-Monitor is ready to work. Available functions of MyCar-Monitor can be 
divided into three groups. 

o Available items in every cases, 
o Items, available when car database is closed, 
o Items, available when car database is open. 

• Buttons and menus are activated and deactivated according to the above criteria’s. 
 
Functions of MyCar-Monitor will be described in the later sections. 
 
During the launching process a start-up screen is displayed indicating the developer 
information, software logo and others.  
 
It is possible to put an additional logo onto the screen to advertise anything, for example 

car manufacturer’s or user’s logo. For details please contact me by email: 
simadcom@gmail.com 
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General rules 

 
• Strings marked with red are mandatory to fill out! In case of they are left empty 

software will display an error message with “Mandatory data is missing”.  

• “…” buttons can be used to add new item to the list.  
• “+” buttons can be used to add numbers together (different costs), 
• Regular database backup is recommended. Only car databases are involved into 

backup operation.  

• If run-time error has been noticed by the software, it generates an “error.log” file in 
the base folder and prepare a menu item in the File menu with which the error file 
can be open.  

• MyCar-Monitor uses “csv” databases and simple text files to store data’s.  More “csv” 
and text files belong to one car.  

• Manual modification of the databases is not recommended!  
 

New car database 
 
How to create new database: 

• Click on the Add car menu item or button. 
• Message will appear with a warning that special characters are not allowed to use in 

the car identification name. Important: these characters are not controlled later! 
 

 

 

• Write the new car name in the dialog appeared. Take into account the previous 
message. 

 

 

 

• Click on „OK” button to confirm database creation process. 
• If the entered database name already exists, you will be warned of this fact. You 

have to decide what to do.  
o Yes - overwrite existing database, losing all the data from the “old” 

databases, 
o No - give a new name, keeping the “old” databases, 
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• „Car datasheet” will appear. 
 
 

 
 

• Fill out as many details as possible on „Car datasheet”. 
• Right click on the picture area can be used to reach some extra picture menu. 

• Fuel tank capacity is necessary for one report. Do not forget to specify that.  
• Click on „OK” button. 
• New database system is ready to open and use. 
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Open car database 
 

• Click on the „Open” menu item or button. 
• If more car database systems are available, the following dialog will appear. 

 

 

 

Comments: vehicle names can be moved from one group into other. Group can only be 
deleted if there is no vehicle specified inside. 

 Do not forget to save the changes after the modification!! 
 

 

• Select the desired car name from the list and click on the open button or double 
click on the vehicle name.  

• Selected car database will be open. 
• If there is only one car database system created that will be automatically opened.  
• Car database system is opened and ready to use. 

 
Opening of the “Last used” database 

• MyCar-Monitor always saves the name of the last used database, so you can re-
open that by clicking on the Last button.  

• Following screen will appear after opening a car database. Active car name is always 
displayed above the left side menu system.  
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Main screen structure 
 
Below picture shows the main parts of the screen (from top to bottom) 

• general menu, 
• main toolbar, 
• alarm indicator, 
• vehicle database toolbar, 

• data and chart area, 
• status bar. 

 

 
 
Second toolbar is only visible when vehicle database is open. Toolbar position can be fixed 
by means of the left- button click menu.  
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Software saves the indicated alarms into an alarm-file which is available via “Open 
alarmlog” menu in the File menu. This menu is activated when a car database is open.  
 
If local help file is available, in the Help menu a “User Guide” menu is visible.  
If online upgrade function is available, two additional menus are created in the Help menu 
with which the online help files (English and Spanish) are available.  
 
Using the “Environment checking” command in the Help menu, the mandatory folders and 
files can be checked. After execution a report file is displayed in which the result can be 
seen. (OK means that the given folder or file has been successfully detected) 
 

Note 
 
MyCar-Monitor provides a logbook possibility for every vehicle. It can be used to store 
smaller notes, to-do list or anything else linked to the given vehicle. 
 
The easiest way to launch it is to click on the Logbook menu item or button. These are only 
activated when a car database is open. 

 
You can write directly any information into the white area and save it by clicking on the OK 
button.  
 

 

 

Car datasheet 
 
MyCar-Monitor provides a datasheet possibility for every vehicle in which you can store the 
most of technical, financial or warranty information about your car.  
 
The easiest way to launch it is to click on the Datasheet menu item or button.  
 
On the datasheet form you can enter the required information and save them by clicking 
on the OK button.  
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Important:  

• fuel tank capacity value is used for one report so it is necessary to fill out, 
• Expired warranty information is marked with red. 
• Fuel consumption specification must be numeric format.  

 
By left clicking on the picture area, extra menus can be displayed. 
 

 

 
With these menus you can specify your own picture of your vehicle.  
 
If you want to record the equipments installed and/or are in your vehicle, click on the 
‘Accessories / Extra’s” button at the bottom of the car datasheet. The following form will be 
displayed where you can define the equipments. 
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Using the part groups and parts, you can select the requested part and add that to the list 
below. Below list is a car specific list, which shows the equipments of the active car.  
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Settings 
 
With this function you can customize your software according to your expectations and 
regional settings. 
Left-side list contains the pages which are available. 
 
List management 
On this form you can modify the lists, such as fuel type or fuel station list. These data files 
can be found in the data folder. These files are used to store specific information for 
MyCar-Monitor. Be careful when these lists are modified!  
Due to safety reasons, car list (“Car.dat”) can not be modified here. 
 

 
 
Chart properties 
On this form you can set the most important chart features. These settings belong to the 
first Fuel Consumption chart. 
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Appearance 
Wallpaper: If wallpaper box is empty, there will not be wallpaper set and displayed. 
Wallpaper is displayed when vehicle database is open and closed. If vehicle specific 
pictures are listed then wallpaper is only displayed when database is closed.  
 
Use skin: with this function you enable the colouring possibility of the forms. Colours can 
be selected in the View menu – Set colours on the main screen.  
 
Use animation: the most important actions are displayed in the right-bottom corner using a 
small rectangle. 

 
 
Show backup dialog: In case of database closure a special window appears in order to give 
the user the possibility to perform a backup about the car database which will be closed. 
 

 
 
Hidden starting mode: software will start and being automatically hidden. Only an icon will 
be visible indicating that the software is running. 
 
Show logon form after launch: an optional form will be displayed where user can select the 
next setp like database creation, opening a database.  
 
Automatic opening of the last used database: last closed database will be automatically 
opened when software is launched.  
 
Visible systray icon: Actual status is always visible on the taskbar icon, next to the 
application name. Systray icons can be enabled and disabled. In case of hidden start mode, 
the systray icon is always visible.  
 
Confirmation request before exit: If confirmation request is ticked, in case of exit 
application will always ask a confirmation before the closing procedure is started.  
 
Use of the XP style (nicer forms and tools). It is not compatible with XP-SP1 and Vista.  
 
Display warning message before due: warning will come into force earlier if there is a 
specified value here. It means that you will have a safety time to act before the valid 
odometer value is reached. 
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Application features 
Status list: it is used in the maintenance module and means the finished status of the 
action. If the specified value is selected in the given maintenance record then that record 
will be closed. Default value is 100%. 
 
Automatic start: MyCar-Monitor is launched every time, when Windows starts. It requires 
administrator rights!! Actual status is indicated by the checkbox next to the button. After 
clicking on the button, the successful and unsuccessful operations are confirmed by a 
message.  
 

 
 
Language 
User can set select one of the available language. Clicking on the OK button, the language 
of the software will be updated immediately. Do not need to restart the application.  
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Measures 
Calculation method should be set according to the standard where you live. In general, 
three calculation methods are:  

• Fuel quantity unit / distance unit * 100 
• MPG 
• Fuel quantity unit / distance unit 

 
Measures are used for reports. Currency is also used within currency module.  
 

 
 
Online functions 
These functions require internet connection.  
In order to activate these functions, user has to perform a successful test operation. 
Check update at starting: Application checks the available upgrades on the internet and 
informs the user if new upgrade is available.  
Checking SimADCom news: Application checks the news on the internet and displays if 
finds a new one. 
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Email server is a replacement of the flashing alarm list. It can send emails in cases which 
are defined on the Rules tab. Preliminary reminder is able to send emails before the action 
is really due according to the parameters specified on the Preliminary Reminder tab.  
 
Administration 
On this form a special security protection can be set. If administrator protection is set, in 
user mode the delete commands can not be executed.  
Setting of the administrator protection is made by adding the passwords and clicking on 
the save button.  
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Sounds 
If this function is enabled, the specified sound will be audible, when a new alarm is added 
to the list. 
 

 
 
Colors 
Double clicking on the selected field the colour of the given function can be set.  
 

 
 

 
Autobackup 
If this function is enabled, then the software will make backup packages automatically 
according to the frequency set.  
 



31 / 131 

 
 
 

General reminder 
 
On this form reminders can be defined which are not linked to the car database systems.  
For example: expiry date of your driving license, birthdays and so on. Just give a name and 
set a date.  
 
Clicking on the „Add this reminder to the database” button, the entry will be added to the 
database and save. Closing this form all the entries will be in live and checked. In case of 
due reminder is detected, that will be displayed in the alarm list on the main panel. 
Using this button”-“, entry can be deleted from the database.  
 
General reminder function can be used when car database is not open.  
Overdue reminders are displayed in the alarm-list when car database is not open. 
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Address book 
 
You can set as many names as you want in this address book database. 
Important: these names can be used on the maintenance, trip and accident forms as 
driver’s or service names. 
Using this button”-“, entry can be deleted from the database.  
 
If website is defined to the given name, clicking on the Visit homepage button, it can be 
directly opened.  
 
If email address is defined to the given name, clicking on the Send email button, new email 
can be generated using the default email client.  
 
The whole database can be exported into different formats by Export function.  
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Catalogue 
 
With this tool you can maintain any type of records, for example vehicle parts, CD/DVD 
discs or anything else.  
 
It is just an extra tool in this software. 
 
New db: create a new database (csv file), 
Open db: open an existing database, 
Close db: close the open database, 
Add record: save the entered information as a new record in the open database, 
Delete rec.: delete the selected record from the open database. 
Export data: export all the record of the open database into one of the available format. 
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Cash 
 
With this tool you can record different type of information, for example family 
income/outcome. 
Actual balance, according to the entered figures, is always displayed, so you can see the 
current status. 
 
This is also just an extra tool of MyCar-Monitor. 
 
Meaning of the buttons is the same as in the Catalogue. 
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Fuel converter 
 
By means of this tool you can make conversion between different fuel measures. 
 

• Write the current value in and select the proper measure (unit of measurement) 
• Click on the „Calculate” button, 
• On the right side the converted figures will appear. 

 
 

 

 
Clicking on the small button, a built-in calculator will be displayed which can be used for 
number entering.  
 

 

 
When the required number is entered, click on the small button again and the calculator 
panel will disappear.  
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Fuel module 
 
This module can be used to calculate and monitor the fuel consumption of your car. 
Using this form you can add/edit fuel records.  
 
The following data’s are mandatory to enter: 

• odometer value 
• quantity of the filled petrol 
• prices (unit and total price) 

 
New odometer value has to be higher then the last one was. If you want to enter older 
odometer data the „Auto-detected function” has to be ticked and used.  
 

 

 

If you want to add new items to any list, click on the small button and enter the desired 
new item.  
 

 

 
If you want to use the Address-book content as driver’s name, just click on the checkbox 
and the list content will be replaced. 
 

 

 

Using the „Driving Style” definition function, you can differentiate the entered records. It is 
necessary, as we know that the average fuel consumption depends on more facts.   
 

 

 

If fill up was conducted during the given trip you can create a link to any existing trip 
record. 
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In some cases it is necessary only to enter odometer values without fill up. Clicking on this 
function all the fuel related fields will be inactive. It is the same function as Update 
odometer command in the File menu. Using this function, the due reminders will be 
displayed in the alarm–list. It can be used for example in case of company fleets.  
 

 

 
 
 

 
 
 
If you want to be sure, that all the calculation is correct, for example after a setting 
modification, you can perform a recalculation on the fuel database. This command will 
completely recalculate and analyse the whole database. 
In case of new database, version upgrade or any calculation setting, the software will 
automatically run this command.  
 
Clicking on one of the record at the right side data table, you can activate a special menu 
with a lot of additional features. 
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Add record: create a new record, 
Edit record: edit the selected record, 
Make Health-Line reference value from this record: selected record will be set as a 
reference for Health-Line calculation. This calculation method is described later.  
Delete record: after a confirmation, delete the selected record, 
Link external receipt file to this record: it is possible to make a link to a scanned invoice or 
any other picture within the selected record. This picture should be in the receipt folder.  
Open external receipt file: if receipt file is linked to the selected record, with this command 
you can open that, 
Delete external receipt file link: delete the link, 
Show/Edit linked trip information: if there was a trip record linked to this fuel record, you 
can see that with this command.  
Driving style specification: with this command you can see or modify the driving style 
parameters of the selected record. After this change, it is recommended to run the 
recalculation.  
 

 

 

Driving style of every trip could be different. In order to take it account, you can specify 
three factors for every fuel records. You can do it when fuel record is entered or modified, 
or you can do it later by right clicking on the given record. 
This setting has an impact on the Health-Line calculation as this calculation bases on the 
fuel records which have the same driving style parameters. 
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Clicking on the information button next to the Distance driven field, the software will show 
a dialog box containing the real and theoretical distance and the difference between them 
in percent. These figures are calculated from the result of the previous records.  
With this tool, the user is able to check the deviation between the real and theoretical 
figures and recognize if one or more fill-ups was not recorded.  
If the given or previous record is not FULL fill-up, then this calculation is not made.  
 

 

 
From version 3503, using the ‘remember’ function, the fuel supplier, petrol station, driver’s 
name and payment mode are saved and used for the next new entry.  
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Template manager 
 
With this tool you can make pre-defined actions which are grouped into one file. These 
actions can be used within service module on the „add reminder” form.  
 
When you create a new reminder, use of the templates will make your work easier because 
you do not have to add every reminder separately. 
 

 
 
How to make a new template? 

• Write the name of the new template into the field. 
• Click on the „Create new template” button. 
• Specify the correct work type and work name. 

• Press „Add to this template” button. 
• With „Close this template” you can close the open template and after create or open 

another. 
 
 
This tool can be for example used to collect and group the spring or winter tasks into one 
template. 
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Reminder 
 
With this feature, actions can be defined in the maintenance module in advance, specifying 
the deadline, when you expect an alarm from the software.  
You have two possibilities to define reminder type and name. 

• using templates, which contain pre-defined actions, 
• add reminders separately selecting the desired type and name. 

 
Scheduled deadline information has to be defined for both types of method.  
Alarm will be generated, when 

• Odometer: when specified odometer value is reached. 
• Date: when the specified date is achieved. 
• Both: when one of the criteria’s, odometer or date, is reached. 
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Maintenance module 
 
With this tool you can record all the maintenance related or any scheduled activity. 
Parameters can be freely set, so it can be used as flexible as you want not just for 
maintenance.  
 

 

 
 

 
 
This form gives you a comprehensive tool to record any type of task made on your vehicle. 
Enter as many details as possible on the form and save them by clicking on the OK button. 
 

Important: every record has to have a status. If the status is set to the value as defined 
on the Settings form, the given record will be closed. As long as the record is open, it will 
appear in the alarm list waiting for a closure.  
 
Note: parts related module is available in the Work Order section from v.4.1.0.0 
 
Clicking on the Add part button, you can specify the parts used for this maintenance. Next 
section describes this module.  
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By right clicking on the parts list area, you can activate some extra menus.  
 

 

 
Delete: delete the selected parts from the list. (it will be possible to account the deleted 
part back into the parts database/stock). 
Warranty until: it generates a date form, on which you can specify the warranty expiry date 
of the given part assembled in. 
 

 

 
No warranty date: delete warranty information of the selected part. 
 
Right click menu on the data table is similar to the Fuel menu described earlier, but there 
are some maintenance specific menus as well.  
 

 

 

Open part database of this vehicle: every car has different part database, which contains 
all the part, used for the given vehicle.  
 
Create payment record: using maintenance record details, new payment record is 
generated.  
 
Clicking on the Check service demand of all car command (Tools menu), the software will 
check all the databases looking for records, which are due. If expired record is found, that 
will be added to the alarm list. This function is available, when car database is not open.  
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Parts database 
 
With this tool you can manage a part database/stock which can be used within 
maintenance module.  
 

 

 
Fill out as many details as you can and click on the Add button to save it in the part 
database.  
If stock management is ticked, the software will check the minimum stock definition and 
real stock level. If stock is less than the minimum stock, alarm signal will be generated.  
If this part database form was launched from the maintenance form, the Add to 
maintenance button will be activated. In order to add a part to the given maintenance 
record, you have to select a part and click on the Add to maintenance button. Next 
message will ask you about the quantity of the part used for the given maintenance. 
 

 

 

If you enter the requested quantity, the software will give a confirmation, that the entered 
part information was added to the maintenance record. 
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Clicking on any record on the database view, the above fields will be filled out with the 
data of the given record.  

 

Scheduler 
 
With this tool, you can add actions, which will be repeated according to the specified 
frequency.  
 

 

 

• Select the work type and work name you want to do repeatedly. 
• Specify the frequency  

o number of months and the next date, 
o odometer value and the next odometer value, 
o both 

• Click on the Add new entry button 
• Close 

 
If the given record is due, this record will be transferred into the maintenance database 
and displayed in the alarm list. Closing this record, the next date or odometer will be 
transferred back to the scheduler database waiting for the next time when it will be due 
again.  
Right side clicking on the record you can activate an extra menu. With this you can disable 
and set the recurrence method of the selected record.  
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If activity is not ticked, then the given record is temporarily disabled. When it is activated 
again, flag of this record is reset, so it is possible that it will be transferred more times into 
the maintenance database. Be careful when it is changed.  
If recurrence is not ticked and activated, then the given action will only be performed once. 
If it has already been performed, the record is frozen so there is no possibility to use that 
again. Be careful when it is changed.  

 
Trip module 
 
With this tool you can record all the trip, excursion or any type of travel made with the 
given car. 
 

 

 
Fill out as many details as you can and click on the OK button to save them.  
 
Right side click on the form, you can activate an extra menu. 
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Clicking on the Load trip details from central database, you can give the same base 
information to more trip records. It is a so-called convoy function, when more vehicles go 
on the same way.  
 

 

 
With New and Edit button you can manage the content of the central trip database. 
 

 

 
Right click menu on the data table of trip module is similar to the Fuel menu described 
earlier. 
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Accident module 
 
Within this module you can record all the accident related information.  
 

 

 
To write „Name” field is mandatory. 
If you want to add new items to any list, click on the small button and enter the desired 
new item. 
If you want to use the Address-book content as driver’s name, just click on the checkbox 
and the list content will be replaced. 
Within Trip ID you can make a link to a trip module, indicating that this accident happened 
during the selected trip.  
Link to any of the Maintenance module can also be made.  
Should you have a police record about the accident, you can build that into the accident 
record.  
Right click menu on the data table is similar to the Fuel menu described earlier.  
 

 

 
As of version no. 3407, counterpart information can be added to any accident entry. 
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Tyre module 
 
Within this module you can record all the tyre related information.  
 
First it is required to create a record in the Global Tire Database for all tires which will be 
monitored.   
 
 

  

 

 

Red marked fields are required to fill out.  
After creation all tire will be identified with the Record ID plus # character and Tire ID.  
All tires have to be linked to an existing vehicle. Please note that purchase cost is not 
automatically transferred into the database of the given vehicle. It has to be entered 
manually into the payment or tire module as it is decided by the user.  
 
Active flag shows that the given tire is in use or can be used. If it is set False then it will 
not be available in the tire module of the given vehicle.  
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It is possible to record three types of entry: 
- in use (to record the use of the tire on the vehicle in different position 

defining the date and odometer intervals) Use of date information is 
mandatory.  

- Operation (to record different actions, like repair, recap, or measurings 
on the given tire with date, odometer and cost information) 

- Combined, in use and operation record together.  
 
Within tire module the tires linked to the open vehicle are listed. Selecting one tire from the 
list the status of that will be indicated.  
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Payment module 
 
Within this module you can record any type of fees which was paid concerning the open 
vehicle.  
 
Payment type list can be freely modified according to the user’s request.  
 
 

  

 

 

Important note:  after closing the payment record can not be modified later. 
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Loan calculator 
 
With this tool you can prepare a pre-calculation in order to see the expected loan details. 
You have to specify the Loan amount, Months of loan and the Annual Interest Rate. 
Entering these information’s and clicking on the „Calculate” button, the application will 
conduct the requested loan calculation.  
You can export the result into more types of format.  
 
 

 

 
 

Export function 
 
Where available, you can export the data content into more different formats as for 
example: 

• Microsoft Excel, 
• HTML, 
• notepad text file 
• csv file 
• and more others…… 

 
You can specify two types of outcome, view only or export directly into a file. 
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Add new entry 
 
With this tool any type of new record can be easily created without going into the different 
modules.  
 
How to make new entry? 

• Just select the correct entry type and click to OK button.  
• Fill out the appeared empty form and proceed according to the normal process. 

 

 
 

Password protection 
 
With this function MyCar-Monitor can be protected. When password protection is active, 
password will be required in case of every starting.  
 
Fill out the password fields. (twice) 
Password reminder function has been removed from v3.4.0.1. 
 

 

 
This form is displayed every time when MyCar-Monitor is launched. 
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If you have lost your password, by right clicking on the password form you can reach an 
extra menu, see below.  
 

  

 
Clicking on the Request unlock key from SimADCom, the following screen will appear.  
This function is only available in the registered versions!  
 

 

 
Clicking on the Request unlock key by email, an email message will be generated using 
your default email client, attaching a file, which contains the information for unlock key 
preparation. This email must be sent without modification to SimADCom. Answer will 
contain a file which can unlock your MyCar-Monitor.  
Received unlock file has to be saved next to Mycar.exe and launch the exe file. Software 
will automatically detect the unlock file and remove the protection. Unlock key will expire 
after a given time which will be included in the answer email.  
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When password is set or disabled, the successful operation is displayed. 
 

 
 

 

 

Backup and restore 
 
You can do the following backup and restore related operations 

• Backup of the open database, 
• Restore of the saved backup files, 

• Complete of all the car database, 
• Definition of the default backup folder, 
• Backup Package Manager. 

 

 

 
Backup 
In order to protect your data or use as portable function, you can save all the information 
of the open car.  

• Select a folder and click OK. 
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• Application will save all databases of the active vehicle.  
 

• Successful backup operation is confirmed by a message below.  
 
 

 

 
Restore 

• Select the folder from which you want to restore the saved files.  
• Select the file which has the same name you want to restore (“dbase_” is added to 

every backup file). 
• If this car database already exists, a message will warn you.  

o Yes-  overwrite  
o No – add new name 
  

This tool can be used as „Save As” function. 
• Backup database, 

• Restore the same database giving a new name to that.  
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Important: in order to avoid the overwriting and loss of any database, application will 
warn, if an existing database is in danger. In this case the user can select what the 
application will do: 

• Overwrite the existing database, so the original data will lose, 
• NOT overwrite, so adding a new name the original database will be kept and a new 

database will be created. 
 
 
 

Backup Package Manager 
 
If automatic backup is enabled in the Settings, then Mycar-Monitor makes backup 
packages.  
Generally, two types of backup can be differentiated: 
- short term: stored in the “backup” folder. It is overwritten every time when new backup 
is made.  
- long term: stored in the “Storage” folder. It is compressed and saved in separate files 
including the date when backup was prepared.  
 
Long term backups need to be extracted into an empty folder by Backup Package Manager 
before restoration.  
 
These backups can be restored as was described earlier.  
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If checkbox at the bottom is checked, password protected byckup package will be created. 
This package can only be extracted with the use of the paasword given during creation.  
 

 
 
If somebody want s to avoid making public backups then autobackup should be turned off 
in the Settings and only use this password protected backup function manually. Password 
protected backup can not be made automatically. 
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Translator module 
 
The reason of this module is to give a tool to the users, who want to make a free 
translation for MyCar-Monitor.  
 

 

 
 
How to make new language file: 

• Open an existing language file, what you would like to translate, 
• Click on the word left side, which will be appeared on the right side where you can 

translate, 
• Using Insert button on the keyboard, left side selection will move down step by step, 

There are two types of string format in the language files (picture no. 90 and 91).  
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In case of second case, commas must not be changed, as this is a list type and commas 
are used to separate them.  
Language files:  

• newlanguage.lng – general language file, 
• new.mes – message file, 
• new.tip – tips od the day strings. 

 
 
From version 3.6.0.5, the translator module is able to recommend words or expressions 
which match with the selected one. This function is available if reference list has been 
made. This list is used to compare and look for words to be proposed.  
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Reports 
 
General chart features 

• Chart area can be magnified by selecting an area by the mouse on that from left to 
right.  

• Original chart size can be set back by selecting an area by the mouse on that from 
right to left.  

• Labels can be added to either average or cumulated consumption. 
 
 

 
 
Fuel consumption 
Fuel consumption: average consumption (when full tank is recorded) 
Cumulated average can be switched off in the view menu. 
Specification limits are taken from car datasheet.  
 
Fuel cost per distance unit 
 
Fuel unit price 
 
Distance per fuel unit 
 
Fuel composition per suppliers 
It shows the actual fuel composition in the tank.  
 
Cost report 
 
Cost report per service works and types 
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Yearly Cost Report 
 
Summary report 
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Comparison report 
 
Clicking on the „Report” button, application will prepare a comparison report about all the 
cars can be found in the databases. 
Comparison is made according to four features: 

- average fuel consumption, 
- total fuel cost (fuel module), 
- total service cost (maintenance module), 
- operating cost per distance (km or mile) unit. 

 

 
 
If there is no enough record, that will be indicated. 
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Special menus 
 
Most of components have been equipped with a special right-click menu with which extra 
functions can be obtained.  
 
 
On the charts, by right clicking you can reach two menus with which you can save or print 
the given chart.  
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Health-Line 
 
Health-Line is a special calculation method with which you can visualize the condition of 
your car.  
Blue line means that no critical deviation is noticed. 
Red line means that something has happened and your car (or your driving style) has to be 
checked. 
 

 
 
Health-Line sensitivity can be adjusted on the Settings/Special 2 tab.  
0 – no tolerance allowed, fuel consumption will be strictly handled and any negative 
deviation an alarm message will be generated. 
0-10% of deviation is allowed compared to the base value. It will result less alarm 
message. It is an optimal value.  
10-20% of deviation is allowed compared to the base value. It will result a very small 
probably zero amount of alarm message.  
 
Health-Line alarm function can be disabled on the Settings form.  
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Driving style definition 
 
Driving style of every trip could be different. In order to take it account, you can specify 
this feature for every fuel records. You can do it when fuel record is entered or modified, or 
you can do it later by right clicking on the given record. 
This setting has an impact on the Health-Line calculation as this calculation bases on the 
same type of fuel records. 
 

 

 
After modifying the settings, it is recommended to run the database recalculation 
command.  
 

Cross references 
 
Between different modules (records) you can make relations. For example: during the trip 
you had an accident. In this case you can make a cross reference between a trip and an 
accident record. On the accident form select the small button next to the trip ID field. 
Below form should be appeared displaying all the records can be found in the trip module. 
Select the correct record and click on the „Make relation” button. ID number of the 
selected Trip record will be transferred into the accident form. 
 
Cross references are based on the ID numbers of the different records. 
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When cross reference has been made and is available, the “Show/Edit ….” menu on the 
data table will be activated in order to reach and see these relations.  
 
 

Advanced bug report 
 
With this tool you can report any type of problem. 
This tool is available in the „Help” menu. 
You have to fill as many data as possible and click on the Send button. An email will be 
displayed containing all the information you defined. You can send the prepared email 
according to the normal process of your email client. 
To receive your configuration files is helpful, in order to make deeper analysis of the 
reported problem.  
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Actual fuel quantity in the tank 
 
Between fill-up’s you can estimate the fuel quantity in the tank with this tool. You should 
only write the actual odometer value and the software will calculate the estimated fuel 
quantity to be in the fuel tank.  
 
You can set the number of the previous fill-up’s taken into account for the calculation. 
 
Fuel-tank capacity must be specified on the Car Datasheet form. 
 

 

 

 

Fuel consumption calculator 
 
This is a simple tool, with which you can make fuel consumption calculation with fictive or 
valid values. 
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V.I.D.S. report 
 
With this tool you can make a portable file which contains the most typical features of your 
vehicle. This file can be sent to other people to read and share that.  
 
In order to make a new VIDS file, you must define a special identification name which will 
be linked to the given vehicle. This name has to be defined only first time. Later it will be 
used automatically.  
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Currency converter 
 
Sometimes it is necessary to convert the cost of a service which was paid in different 
currency as used by the software in default. For example when you were on abroad and 
fill-up was paid in local currency. This tool helps you in this by maintaining a special 
currency database and making the expected conversion.  
I think this tool can be mostly used by international drivers, for example truck-drivers.  
 
Before using it, you have to fill up the database with data’s.  
Click on the Update Currency Database to open that. 
 

 

 
On the next form clicking on the Add button, you can add new entry to the database. 
Added entries will be automatically transferred into the previous form, where you can use 
them.  
 

 

 

Exchange ratio can be easily calculated with the below calculator which automatically fill 
the ratio field out. Above sample picture shows the operation of this calculator tool.  
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On the currency form (picture 113.) write the paid amount of money and currency in and 
software will convert this value to the default currency. Clicking on the OK and copy to 
Clipboard button, the result will be copied to the Clipboard and written into the field if this 
command has been launched from a module form. 
 

Petrol station and price database 
 
This tool can be used to prepare a list of the petrol station where you usually fills your car 
up.  
All the record is converted to the default currency so you will be able to compare them and 
decide where you should fill up next time.  
 
 

 

 
 
Clicking on the Update button, the database will be recalculated, using the actual currency 
ratios.  
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Car Care related link collection 
 
Surfing on the net you can find interesting sites what you would like to save and use later. 
With this tool you can store them in the Car Care related database.   
 
Should you have a site address what you suggest we should put into the install package, 
just send us by clicking on the send link button.  
 
 

 

 
 
 

Rules and Alarms 
 
If you want to set special alarms, this tool will help you in that. Clicking on the add button, 
you can define new entries. 
 

 

How to add new entry? 

• You have to give a name for every entry.  
• Select the module and field which will be the subject of the new entry. 
• Specify the condition, limit value and message should be displayed when this entry 

will be active.  
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Following form will be displayed, when the given rule is due. 
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Part selection 
 
There are more pre-loaded parts group and list available in the software built-in.  
 
Parts are grouped into different categories, which are listed in the above field. Selecting 
the desired parts group, the individual parts will be loaded into the below list.  
 
These lists can be modified according to your wish.  
 
 

 

 
 

Automatic database backup function 
 
Before closing the database this form appears initiating a backup process. You can choose 
between performing the backup and close the database or close the database without 
backup.  
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Choosing backup function you will be asked about the place of the backup files to store. In 
order to make the decision easier, the last used and default folder is displayed.  
 

 

 
Successful backup operation is confirmed by the below message. 
 

 

 
This function can be switched off any time by ticking the “do not show the question next 
time” checkbox at the bottom of the form.  

 
Delete car 
 
You can reach this function in the File menu.  
 
Choose the car name you would like to delete and click on the delete button to continue.  
 
 
 

 

 
This message will warn you that this operation can not be withdrawn. Clicking on the Yes 
button, all the database and other files and entries will be completely deleted.  
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General Setting Functions 
 
Set Table 
 
Most of grid (database view) has been equipped with this function, with which the grid 
properties can be modified according to the user’s expectations.  
 

 

 
On this form, columns visibility and width, title and data properties can be modified.  
These parameters are saved into different dat files in the “column” folder.  
 
Find 
 
Most of grid (database view) has been equipped with this function, with which the user can 
search in the database. 
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TWAIN 
 
If any digital photo device is connected to the computer, with this tool the user can 
download the pictures and save into onto the hard-disk. This is only a simple tool because 
picture handling is not the main object of this software.  
 

  
 

Two picture format can be selected, BMP and JPEG-JPG. Clicking on the button, the 
software will list the available devices.  
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If there is no device available, error message will be displayed.  
 

 

 
 
 
Downloaded pictures can be seen using the built-in simple picture viewer. 
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Calendar 
 
In case of “Next date” fields, this calendar can be launched by right clicking on the given 
date component (for example: next date field of maintenance scheduler).  
 
 

 

 
By double clicking on the desired date, the date value is copied in the date field. 
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System message 
 
If online upgrade function is available, the software is able to get and display message 
from SimADCom server. These messages are displayed on the task bar icon.  
Messages are showed after MyCar-Monitor start and for approximately 30 seconds.  
Every message is identified with a so-called NoteID. If the user clicks on the message, the 
given NoteID will not be displayed again.  
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Race module 
 
With this tool any type of race ranking can be documented and displayed on simple charts.  
User is able to create any number of databases. After opening them, using the add race 
entry form, any number of records can be added.  
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Fields on the add form have to be filled out and click on the OK button. After adding this 
race information to the database, the software will update the charts accordingly.  
 
 

 

 
Database view is equipped with the general menu functions as Add, Edit, Delete entry, Set 
Table, Find and Export.  
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Home book-keeping module 
 
With this tool the expenses and incomes can be managed and displayed on a simple chart.   
User is able to create any number of databases. After opening them, using the add 
expense or income entry form, any number of records can be added. Actual balance can be 
seen on the chart page.  
For example, this tool can used to maintain the cost of a self-employed car mechanic or a 
family.  
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Following form can be used to add or edit expense entries. 
 

 

 
Following form can be used to add or edit income entries. 
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To-do list and time tracker 
This is a simple tool to follow up any type of activity and see the spent time. For example: 
elapsed time of a vehicle repair or a list of the tasks what you want to do in the near 
future.  
Meaning of the record colours are: 

- green – closed record (checkbox is ticked on the form), 
- yellow – open record, due date is in the future, 
- red – open record, due date is in the past (overdue). 

 

 

 
New entry can be added or modified on the following form. 
 

 

 
Clicking on the “Start / Stop Tracker” button, timer function of the selected record can be 
started or stopped. In case of stopped status, the “RunningStatus” field on the database 
view contains the following text: X-X-X-X. 
Timer information is recalculated in case of every operation, such as add, edit record or 
start, stop tracker. 
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By right clicking on any record in the database a special menu appears with which 
additional functions will be available.  
Set Tracker to Nul – delete all tracker information, record counter will be zero. 
Refresh Tracker Counter – Update Tracker time calculation. 
Show Tracker Inormation – displays the tracker information of the given record (see 
picture no. 149) 
Show History Database – Start and Stop operations are saved into a separate database 
(see picture no. 150) , so any time it can be seen that the given record when was started 
or stopped. This database can be exported to Excel for further analysis.  
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Inventory module 
This is a simple tool to organize any type of belongings. For example: tools in the garage 
or service. 
First step is to create a new database. Any number of databases can be created, but all 
databases are separated, there is no relation between them.  
Opening the database, records can be filtered by location and category. In the Items list, 
the filtered records can be seen. Clicking on any record in the Items list, right side fields 
will be filled out. These fields can be modified, overwritten or added to the database as a 
new record.  
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On the next page, general information can be added to the database, for example: subject 
of the inventory activity, country, street, city, postal code and others. 
Item-list can be freely modified, by clicking on the small button right side and adding new 
items.  
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On the next page, the repairs and linked information can be maintained.  
For every item on the first page, any type and number of link can be added on this page. 
Upper two fields show the actual item. By filling out the bottom four fields and saving it by 
the buttons, a so-called item related link will be generated. On this page you can see the 
complete link database and a filtered one. Filter operation is carried out based on the 
selected item in the complete database or in the item-list on the first page.  
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On the next pages the complete inventory database and the linked pictures can be seen.  
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Features 
 
It displays the functions which are available in different registration statuses.  
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Alarm system when existing data-file is detected 
 
This software uses a lot of data files located in the “data” folder. If existing data-file is 
detected, which may cause data inconsistency, software will warn the user.  
On this form the content of the existing data file and the name of the new file are 
displayed. User has to decide that the expected data-file will be in line with the desired 
content or not. If not, the process can be interrupted by clicking on the interrupt button. In 
this case new list-name can be chosen and the data-file creation process can be started 
again.  
Clicking on the Continue button, the new data-file will contain the items listed below.  
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Date Time difference calculator 
 
This is a bonus tool for VIP user with which the difference of two dates can be calculated.  
Every field contains the total value calculated in the given measure.  
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Special thank 
 
Those people who have contributed in the development of MyCar-Monitor are listed on the 
“Special thanks” form.  
 
Following activities are awarded by this way: 

- beta testing, 
- translations, 
- useful ideas or feedbacks. 
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Help to keep MyCar-Monitor FREE 
 
Should you have any possibility to promote my software, I would appreciate that.  

• You may send an email to your friends promoting my software. Please send my a 
copy as well.  

• You may place a link onto your website. 
• Any other type of support 

o Software download possibility from a site, 
o Software information displayed on the web-site, 
o ……. 

 
These types of activities are compensated with VIP rights.  
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Auto Backup 
 
Software is able to make backups about all the car databases automatically. It is default 
setting.  
 
Auto Backup is performed in case of every launch as it is specified in the Settings. 
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Download system messages 
 
User is able to download all the System messages (see picture no. 134) from the internet 
server in order to read the changes and important news distributed.  
 
Successful on-line update testing is necessary for this function. That test proves that the 
given PC is able to reach the internet.  
 
This command can be found in the Help menu. 
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Product Satisfaction Survey 
As the user’s experiences and feed-backs are very important for me, the new version has 
been equipped with a so-called Survey functions. With this tool, the user is able to express 
her/his opinion about the software and send me for analysis. These feed-backs are 
necessary for the further development. 
 
This function is available in the Help menu. 
 

 
 

 
 
 

The wizard type forms will guide the user through the process.  
This function is available only in English.  
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VIP launcher  
This is a simple tool for VIP users with which any application or website can be launched 
together with MyCar-Monitor.  
Specified apllications and websites are launched when MyCar-Monitor is starting. 
Maximum three entries can be added to the list.  
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VIP file operator 
This a simple tool for VIP users, with which general file operation can be executed. Only 
one operation can be set.  
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Fleet Manager 
This is a tool with which the availability and use of the vehicle fleet can be managed.  
Any number of databases can be created according to the user’s expectations. After 
opening a database, the records are loaded into the table and ready to use them.  
 

 

 
 
Meaning of the colours: 

• Green – closed, 
• Yellow – reserved, 

• Blue – service, 
• Red – on the way, 
• Gray – out of use, 
• Transparent – returned, not closed.  

 
Important: please check the settings on the Queries page. These settings have significant 
impact on the fleet manager’s operation.  
 
On the Queries page user is able to look for available vehicle or to check the current 
location of any vehicle (see picture no. 165).  
 
On the Graphic view page, the availability of the vehicles is visualized (see picture no. 166). 
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Energy Module 
This is a simple tool with which the energy consumption of any garage or building can be 
managed. For example: natural gas, water or power. 
Any number of databases can be created. After opening a database, that will be loaded 
and ready to receive and store new entries.  
On the report form, the daily energy consumption is automatically calculated and 
displayed.  
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Driver Module 
This is an additional database, in which the driver specifiic information can be stored. Any 
number of records can be added.  
Driver database is used within trip, fuel and accident modules.  
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Policy Details Module 
This is an additional database, in which the policy details can be stored. This database is 
used within payment module.  
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Flex-Report module 
 
With this flexible reporting tool, user is able to create special reports.  
Starting with the first section, user has to define the conditions what the software has to 
use when report is generated. After defining all the conditions, clicking on the Create 
Report button, the software will create the report using the set criteries.   
If the report is ready and tested, user can save that by clicking on the Save Report button.  
 
 

 

 

Meaning of the 7 sections is the following 
1. which database will be used? 
2. which field of the selected database will be used for the record selection/filter? 
3. type of the field specified in section 2. 
4. operation symbol for the record selection/filter. 
5. value for condition/filter 
6. y axis value. Datatype of this field must always be numerical format!! 
7. calculation method 
8. x axis value.  
9. grouping method of the X. 
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Icons 
 
Meaning of the taskbar icons. 
 

= application is just loading or connecting to internet. Please wait! 

= application is loaded, no car database is open.  

= application is loaded, car database is open. 
 

 
 
 

For Windows Vista users 
 
Problem: runtime error when maintenance form is displayed.  
 
Solution: below function has to be disabled (“Mycar.exe.manifest” file has to be renamed). 
 
Cause: incompatibility with Vista UAC (User Account Control). 
 

 

 
 
From v4.2.0.2 a new exe file is built into the setup package with a name of 
“Mycarmfst.exe”. This exe file has a built design improvement.  
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Picture Collection 
On the main screen, when car database is open, the user is able to collect and display 
pictures about his/her car.  
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Clicking on the first button, an administrator interface will appear. On this area the user is 
able to add, edit and delete pictures form the list. This list is car dependent, so every car 
database has a separate picture collection.  
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Depreciation and Cost pre-calculator 
 
With this comprehensive tool the user is able to make a pre-calculation for car purchase. 
This interface is divided into five parts.  
Analysed period 

- user has to select the first year, when the analysis starts, 
Actual vehicle parameters 
New vehicle parameters 
Savings / Cash 
Calculation  

- it is made by the software 
 

 

 

 
Rules: 

- this tool is still in beta phase, 
- after filling out the blue filed of the given row, click on the small button which 

will fill out the white fields automatically, 
- within calculation area, by clicking on the small graph button, the given row 

will be transferred into the chart on the next tab, 
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Route Time and Cost Calculator 
 
With this tool the user is able to make a pre-calculation of his/her trip taking into account 
the pauses, distance, road types, prices and so on. 
 

  
 

 

 

After analysing the input data, the software will provide the key figures of the trip, e.g.: 
number of fillips, needed petrol quantity, duration of the trip and cost of the trip. 
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Associated Documents 
 
With this tool you can collect and list all the documents belong to the given car. 
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Estimation Analysis 
 
With this tool you can estimate the  

- odometer which will be reached on a given date 
- date when the given odometer will be reached 
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Running Analysis 
 
With this tool you can make fuel report between two specified dates. 
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Period Analysis 
 
With this tool you can make text-based reports from fuel, maintenance and payment 
modules.  
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Alarm-list function 
 
When any maintenance or payment item is due based on the odometer or date 
specification, it will be transferred into the alarmlist and flashing there while the given 
action is not completed.  
If there is no any item transferred, the alarmlist is hidden.  
 

 
 
 
 
Using the right click menu the following functions are available: 

- open the given item, 
- stop / start the flashing signal, 
- hide alarmlist, 
- prepare an email message containing the items of the alarmlist, 
- prepare a text-based report containing the items of the alarmlist. 
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Frequently Asked Questions (issues on the forum) 
 
Q – How is the fuel consumption calculated? 
A - First average value will only appear when the second record has been entered with 
ticked full fill up parameter. First record is just used to be a base, where the application 
starts to calculate the quantity of the filled fuel and the total distances. 

 

 
Q - What does Health-Line mean? 
A - Health-Line basically represents the consistency and reproducibility of the average 
consumptions. It shows the stability of the fuel consumption per parameters (place, load 
and driving style ticked when fuel record is entered). Usually the first average value from 
the given parameter variant is taken into account as a basic, and the next values are 
compared to this. Base value can be changed by the user. Results above zero means that 
the given average is significantly worse than should be in case of the given parameter 
variant.  
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Q - Entering Fuel records...  
I notice several other posts regarding errors encountered entering odometer readings, the 
reply being it has to be higher than the previous entry. Is there a way that this could be 
changed to enter in readings in any order? I say this because I have a glove box with 
hundreds of receipts for fuel bought ever since I owned my car and don’t want to have to 
go through and put them in date/odometer readings first before entering into the Fuel 
Module of MyCar-Monitor. 
A – Using the "Auto-Detected record position" on the add fuel entry form, this request can 
be fulfilled.  
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How to use the maintenance module? 
 
As it was written by more users that the maintenance module is a little bit complicated, so 
I have created and added this section to this userguide in order to give a more detailed 
explanation to this fucntion.  
This module is able to handle three types of actions 

1. Reminder  
2. Maintenance record 
3. Scheduled actions 

 
Reminder 
Purpose: to write an action into the database specifying a date or odometer value in order 
to avoid forgetting that.  
Frequency: individual entry which will be happening once.    
Recorded information: name and type of the action need to be done, date and/or 
odometer value. 
Templates: it is allowed to use pre-defined action lists so called templates.  
Data storage: record is written directly into the maintenance database. 
Data modification: record can be modified any time later.   
 

 

 
Description of the reminder function: when a new reminder record is entered, it is directly 
written into the maintenance database. If the specified date or odometer value is over, the 
given record will be transferred into the flashing alarm list indicating that action is needed. 
After opening this record, the normal maintenance form will be displayed where the user is 
able to record all the other information and decide that the required action is done or not. 
If it is done, then the status field has to be set to the mark of finished action, in default 
100%.  
 
 
 
 
Maintenance record 
Purpose: to write an action into the database when most of the required data’s are known.  
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Frequency: individual entry which will be happening once.    
Recorded information: all the maintenance related data’s can be recorded. . 
Templates: it is not allowed to use pre-defined action lists so called templates.  
Data storage: record is written directly into the maintenance database. 
Data modification: non closed record can be modified any time later.  In case of closed 
records, modification is not possible.  
 

 

 
Description of the maintenance record function: when a new maintenance record is 
entered, it is directly written into the maintenance database. If the specified date or 
odometer value is over, the given record will be transferred into the flashing alarm list 
indicating that action is needed. After opening this record, the same maintenance form will 
be displayed where the user is able to record all the information and decide that the 
required action is done or not. If it is done, then the status field has to be set to the mark 
of finished action, in default 100%. 
 
Scheduled actions 
Purpose: to write a recurring action into the database in order to repeat that according to 
the pre-defined frequency.  
Frequency: it can be defined by number of months and/or odometer value.     
Recorded information: name of the action need to be done and frequency. 
Templates: it is not allowed to use pre-defined action lists so called templates.  
Data storage: record is written into the separate scheduler database. 
Data modification: record can not be modified after closure. Closure means that the status 
of the record is set to closed type (normally 100%).    
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Description of the scheduler function: when a new scheduler record is entered, it is written 
into the scheduler database. If the specified date or odometer value is over, the given 
record will be transferred into the maintenance database creating a new maintenance 
record and in parallel it will also be transferred into the flashing alarm list indicating that 
action is needed. After opening this newly created maintenance record, the normal 
maintenance form will be displayed where the user is able to record all the other 
information and decide that the required action is done or not. If it is done, then the status 
field has to be set to the mark of finished action, in default 100%. If the status has been 
set to closed, then the given record in the maintenance databse will be finally frozen which 
means that it can not be modified later. The reason of this protection is to avoid the 
incorrect relation between scheduler and maintenance database records because they are 
working from each other. When the newly generated maintenance record is closed, then 
the next date or next odometer value of the original scheduler database record is 
automatically updated according to the pre-defined frequency value. When this new date 
or odometer value is over, the above mentioned process will be repeated.  
Scheduler records can only be modified in the scheduler database. After every modification, 
the updated record will be used for the next maintenance record generation. Record can be 
modified by using the right click menu on the given record. Scheduler record can only be 
modified when there is no waiting action in the maintenance database triggered be the 
given scheduler record.  
Scheduler record has two additional properties, activity and recurrence. Using the right 
click menu on the record, these functions can be enabled and disabled. Activity means that 
the given record is not used while this status is disabled. Recurrence means that the given 
record will only be transferred into the maintenance database in one case, so repeat 
property will not be used.  
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Handling of hybrid fuel system 
 
Within fuel module it is possible to handle hybrid fuel system from version 3503.  
 
First step is to activate this function by selecting the last menu from the right-click menulist 
on the database view. With this menu, the hybrid system can be enabled or disabled.  
When this function was enabled, a new menu item will appear on the first position with 
which the user will be able to change the active database between default and secondary.   
 
 
 

Observation module 
 
Within this module the user is able to record all the observation which were detected, for 
example increased petrol smell, noise or decreased performance.  
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Modification module 
 
Within this module the user is able to record all the modification done on the vehicle for 
example tuning, performance related testing.   
 
 

 

 
Lending module 
 
Within this module the user is able to record all the event when his/her vehicle was given 
to any other person.  
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Work Order 
 
Purpose of this module is to store all the required details of the given maintenance record, 
print out the details and finally the invoice.  
 

 
 
 
When all data is filled out, the work order has to be closed and then the “Print Invoice” 
function will be activated. On the special tab it can be withdrawn anytime.  
 
Work Order no. is created automatically, but can be modified anytime later on.  
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About MyCar-Monitor 
 
Using “About MyCar-Monitor” command in the Help menu, the version and registration 
information can be displayed.  
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